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INTRODUCTION TO WRITER
Writing a Conference Call Letter

LEARNING OUTCOMES
Words are crucial tools of a teacher's trade. As a teacher, you owe it to yourself and to your
students to use words well. The LibreOffice word processor will help you improve your
writing skills because it makes revision easy and thus encourages you—and your students—
to correct errors in grammar, spelling, and style.

In this tutorial, along with some helpful hints to bear in mind when word processing,
you will learn the steps required to produce a word processed document from scratch and
carry out basic formatting and editing functions. These include:

opening and naming a new word processor document
entering and saving a document

updating and simple formatting of a document
checking a document for spelling and grammar errors
printing a document

making a backup copy of a document

It is likely that you are not a beginner to word processing, so you may think you don't need
to complete this tutorial. That would be a mistake. Most computer users learn no more than
the minimum they think they need to know to use a program such as Writer, without taking
the trouble to learn other useful features of the software. In other words, even if you have
used a word processor for a while, there's a good chance that you will still benefit from
completing this tutorial.

So, with this in mind, please conscientiously work your way through the tutorial with a
view to learning new things. You'll be surprised what you’ll discover!

BEFORE YOU BEGIN

A caveat (warning) before you begin: You'll find it easiest to use this tutorial if you follow
the directions carefully. On computers there are always other ways of doing things, but if
you wander off on your own be sure you know your way back!

Lesson 1 makes the assumption that you are already familiar with the Windows computing
environment, though you may not be an expert in its use. If you are using a computer in a
lab at school, you'll also know:

e where to find the computer lab on your campus;
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e how to turn the computer on;
e how to log on to the system (using your login name and password).

You also should be familiar with the Windows, Icons, Menus, and Pointers (the so-called
WIMP interface) with which you interact with the computer. If not, your instructor will
make this clear to you before you proceed with these tutorials.

Lesson 1 assumes that you have received a copy of the set of Work Files for LibreOffice
5 that accompany these tutorials. These files ideally should be stored on a USB drive (USB
drive) in three folders named Access Files, Impress Files, and Miscellaneous Files. You
also will need a fourth folder for the data files that you will be creating while working your
way through the tutorials. This fourth folder will be called Data Files.

If you do not have these four folders and files ready, prepare them now before
proceeding with this tutorial. Here are the steps to take:

First, Unzip the set of Work Files for LibreOffice 5 by double clicking
on the File name on your computer (your instructor will help you with this
if you are working with a class) and Extract them onto your USB drive

Double click on the Work Files for LibreOffice 5 folder to open it

Now, inside the Work Files for LibreOffice 5 folder you need to create a new, fourth, folder
called Data Files. Here’s how you do this.

In the Work Files for LibreOffice 5 folder, select New Folder (Fig. 1.1).
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Fig. 1.1 Creating a New Folder

The system will create a new folder for you and then wait for you to give it a name of your
choice (Fig. 1.1 above).

Call the new folder Data Files
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During the course of these tutorials you will be storing many files in this Data Files folder.

1.1 OPENING, NAMING & SAVING A NEW WRITER DOCUMENT

Opening a new Writer document

Before you can use LibreOffice, you must first open the program. Every system is slightly

different in the steps to open a program, so we’ll assume that you already have that figured

out, or you have someone, such as your instructor or a friend, who can help you get started.
Fig. 1.2 illustrates the screen you will see when you first open a new Writer document.
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Fig. 1.2 New blank Writer document (annotated)

Notice the default title that Writer has given the document (Untitled1). You will be changing
this shortly when you save the document for the first time. Fig. 1.2 illustrates the toolbars
(Menu bar, Standard and Formatting bars) that are available when you open any new Writer
document. Fig. 1.2 also illustrates the Ruler Bar, along with the tool for setting tab stops
and the tools for setting indents—called indent markers. Most users of Writer never figure
out how to use these tab stops and indent markers; many users do not even know they exist!
By the time you are done with these tutorials you will be very familiar with them.

Check out the tool for setting Tab stops; it's on the same line as the
Ruler bar, but at the left edge of the Writer window (see Fig. 1.2 previous
page)—it's so small you could easily miss it (a lot of Writer users do!)

You’ll be practicing using this Tab Stop tool later in the tutorial; note where it is for now.

Make a mental note of the Indent Markers, too; they’re on the left and
right sides of the Ruler bar (Fig. 1.2 again)

Naming & saving a new Writer document
In the following exercises, use your USB drive to save the files you’ll create.

Look at the new document’s default name (Untitled1) at the top left of
the Writer window (see Fig. 1.2 above)
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The document is given this default name by LibreOffice because you haven't yet given it a
name of your own. It is ALWAYS a good idea to immediately—and thoughtfully—name a
new document before you even begin to enter any data, and then save the document on the
drive and in the folder of your choice. It’s not a bad idea to save a backup copy, too (you’ll
have the opportunity to create backups at the end of each lesson of these tutorials).

There are two good reasons for naming your files thoughtfully:

1. Youwill be able to identify the contents of a document if you give it an appropriate
descriptive name (such as Letter to Mom 3-8-04). A thoughtful name will also
help you find a document, because you can have the system search for it.

2. You will more easily find a document if you save it in a location of your choice.

Make sure your USB drive is inserted in your computer (or follow your
instructor’s directions) then, from the File menu, select Save As

Writer now displays the Save As dialog box (Fig. 1.3).
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Fig. 1.3 The Save As dialog box
As you see in Fig. 1.3, the Save As dialog box prompts you, among other things, to

(1) select the location or disk drive where you want to save the new document (in
this case your USB drive);

(2) navigate to, and then either create or select, a folder on that drive in which to
save the new document (in this case, your Data Files folder);

(3) type a name for the document before clicking on the Save button.
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The Save As dialog box thus helps you select the location where your files can be saved.

Make sure your USB drive is in one of the available USB ports in the
computer then, in the left frame of the Save As dialog box, click on
USB Drive to open it (Fig. 1.3 on the previous page)

Now, in the list of various folders and files that may be on your USB
drive, locate/navigate to the folder named Work Files for LibreOffice
5 (you may need your instructor to help you find it on your computer this
first time) and double click on it to open it

You should now see a list of four folders, including the Data Files folder you created when
you prepared it for use with these tutorials.

Double click on the Data Files folder to open it (see Fig. 1.3 previous

page)
Creating a new folder on a disk

Inside the Data Files folder you need to create a new folder to store all the documents you

will create using Writer.

Still in the Save As dialog box, click on the New Folder icon (Fig. 1.4)
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Fig. 1.4 The New Folder icon in the Save As dialog box

The system immediately creates a New Folder with a default name highlighted in blue,

inviting you to type a name of your own for the New Folder.

For the new folder's name type Writer Documents, hit the Enter key,

then double click on the folder to Open it
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Writer opens the new folder so that you can save the new document inside it (Fig. 1.5).
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Fig. 1.5 Naming the Conference Call Letter

In the File name: data entry box (Fig. 1.5), type Conference Call Letter
to replace the default name and press Enter (or click on the Save
button)

The Save As option thus allows you to name your documents and at the same time determine
the location (the folder, on a particular disk) on which you want to store them. In effect, by
naming the document and specifying the location on which it will be stored, you are
reserving a space for the document on the disk.

From now on, you do not need to select Save As to save the document unless you want
to save a backup or save it in some other location. Whenever you simply Save this particular
file, it will be saved with the name Conference Call Letter in this same folder (Writer
Documents) on your USB drive.

1.2 SOME HELPFUL HINTS WHILE USING WRITER
You will shortly type the text of the Conference Call Letter. But before you do so, check
out the following helpful hints.

Word processing is not the same as using a typewriter
Next to no one uses a typewriter anymore. But if you happen to be one of those who have
never yet used a computer, but you did used to use a typewriter, read on.

As you type at the computer keyboard, the characters (letters of the alphabet, numbers,
etc.) appear on the screen. When you use a typewriter, however, the letters appear directly
on the paper in front of you. Also, when using a typewriter you have to move the carriage
that holds the sheet of paper in place back at the end of every line so that you can start typing
at the beginning of the next line on the page. This is called a carriage return.
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When you use a word processor, however, the system takes care of the end of each line. As
you type away in word processing, the program is aware that you are getting to the end of
the line, and it will automatically move a word to the beginning of the next line if it doesn't
fit completely on the end of a line. The technical term for this is “wrap around.” You don't
have to worry about hyphenating words that are broken up over two lines—unless you want
to, of course.

So, when you are using a computer, the only time you need to hit the Enter key is at the
end of a paragraph, whether the paragraph be an empty line, just one word, one line, or
several lines.

Type the following passage for practice—remember, don't press the
Enter key until you get to the end of the paragraph?

And though he tried to look properly severe for his students, Fletcher Seagull suddenly
saw them all as they really were, just for a moment, and he more than liked, he loved
what he saw. No limits, Jonathan? he thought, and he smiled. His race to learn had
begun.2

Now press Enter at the end of the paragraph
Notice how the word processor took care of the end of each line.

Removing unwanted Returns (using the Show { option)

You can have Writer show you exactly where, in your document, you hit the Enter key (say,
at the end of paragraphs). The easiest way to do this is to click on the Show { icon in the
Standard Toolbar (Fig. 1.6).
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Fig. 1.6 The Show Y icon on the Standard toolbar
Click on the Show { tool now

The § symbol is the standard mark used by editors to indicate the need for a paragraph break
in running text. In the Conference Call Letter that you’ll be typing shortly, the { symbol, if
you have the option turned on, would appear wherever you hit Enter at the end of each
paragraph. Another § symbol would appear on an empty line because, strictly speaking, the
empty line is another paragraph break.

1 The lines on your screen may be longer or shorter.

2 From the book "Jonathan Livingston Seagull: a story” by Richard Bach. New York, NY: Avon, 1970. And
yes, the grammar is correct, so don’t worry if it seems odd to you here and there!

10
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The Show { tool also puts a dot to show wherever there is a space in the running text. This
is useful for you to see if, for example, you have typed extra spaces here and there that you
may want to remove.

Position the cursor immediately before the sentence that begins “No
limits, Jonathan?...”, then hit the Enter key twice

Notice the  symbols that show you where you hit the Enter key—one at the end of the
previous line, and the other on the empty line ahead of the cursor.

Now remove the Paragraph marks you just entered by pressing the
Backspace key twice

Finally, click on the Show T icon in the Paragraph Group of the Home
Ribbon to turn off the paragraph marks and all the dots between the
words

Undoing unintended actions

If you do something you didn't intend, or if you make a mistake, you'll select Undo from the
Standard toolbar which is located immediately below the Menu Bar (Fig. 1.7). This is a
lifesaver that you will use often!

Menu
Bar Undo/Redo

riter - tOOIS

JAY
File Edit View Insert Format Styles Table Tools Window Help J

B-8-@dea B 400 Xv 1 =200

DefaultStyle =] (&5 (&) ||Liberation Serit  [+] 12 [7] Click o this Sma““artho drop L .|

A H 3 N F . down a list of recent actions

L

Standard
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Fig. 1.7 Undo/Redo tools

Check out this Undo/Redo option in the Standard toolbar now so you
can see where to find it when you need it

A quicker way to Undo is to use the shortcut Ctrl+z on your keyboard. You also can undo
any number of specific recent actions by clicking on the small arrow next to the Undo tool
in the Standard toolbar (Fig. 1.7 above), which will drop down a menu or list of the various
actions you have taken since the last Undo. Be careful when you use this feature, however,
because if you undo, say, 10 actions, all the actions you did prior to that will also be undone!

Scrolling through a document
We need to open a longer document so you can practice different ways of scrolling.

11
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From the File menu select Open, navigate to your USB drive and locate
the Work Files for LibreOffice 5 > Miscellaneous Files > Practice
folder, and double click to open the document called Term Paper

Now, with the Term Paper document open on the screen, look at the scroll bars (Fig. 1.8).
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Fig. 1.8 The scroll boxes

On the right of the screen you have a vertical scroll bar and, inside it, the vertical scroll box.
At the bottom of the screen you have a horizontal scroll bar and horizontal scroll box.

At either end of the scroll bars are arrows pointing in opposite directions (left and right,
or up and down). As you might expect, clicking on these arrows will scroll a document left
or right or up and down. Scrolling from left to right or right to left is simpler than scrolling
up or down, since you only have the width of the page to deal with. But the process is the
same for scrolling up and down, too.

Try scrolling now from side to side—left to right and back again—by
clicking on the scroll arrows to move the scroll box in the horizontal
scroll bar

Try scrolling up and down by clicking on the scroll arrows to move the
scroll box in the vertical scroll bar

12
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You can scroll a lot faster by positioning the mouse arrow on the scroll box itself, holding
down the left mouse button, and dragging the box left or right, up or down, in the scroll
bars.

Try this, too

If you click either side of the scroll box inside the horizontal or vertical scroll bars, this
causes the document to scroll in jumps from side to side or up and down.

Try this as well

You also can scroll and position the cursor very precisely across a line of text, character by
character, or up and down from line to line, by using the arrow keys on the lower right of
the keyboard.

Try this as well

Finally, yet another vertical scrolling option is available if you have a mouse with a
rubberized wheel between the buttons, as illustrated in Fig. 1.9.

/®
the business” »

Fig. 1.9 The scrolling wheel on the mouse
Try this, too

When you have finished experimenting with the scroll bars, close (File >
Close) the Term Paper document

Shortcuts or quick keyboard commands
The quickest way to save your work is to press Ctrl+S on the keyboard.

The Ctrl (Control) key is in the lower left corner of the keyboard. Locate it now. You'll
be using it a lot as you become more familiar with the Office programs. It is always used in
combination with one or two other keys. Ctrl+S, for example, is executed by holding down
the Ctrl key and, while holding the Ctrl key down, at the same time quickly hit the S key.

13
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You'll learn more shortcuts as you work your way through the tutorials. The author has
prepared a chart that breaks down the most used Writer quick keyboard commands. You
will find this chart handy when you are learning to use the software for the first time. The
chart is available as a separate download at the end of the list of contents on the download
site for these LibreOffice tutorials (http://www.pitt.edu/~poole/libreoffice5frame.html).

For ready reference, you may want to print out the Quick Keyboards Commands sheet
which lists the most frequently used LibreOffice shortcut keyboard commands.

Renaming a document

You will sometimes want to rename a document that you've already saved on your disk.
One way you can do this from the desktop is by right-clicking on the icon for the document
you want to rename. Then, from the context menu that pops up whenever you right-click on
an object on the screen, select the option to Rename..., which highlights the document’s
name so that you can type a new name for it.

To rename a document which you already have open in Writer, or in any other
LibreOffice application, you would choose Save As from the File menu. This will give you
the opportunity to save the document with a new name of your choice.

Bear in mind, though, that when you do this, the document with the original name will
still be on your disk—a second copy, if you like. If you don't want to keep this copy, you
should delete it right away so as to remove unwanted clutter from your disk drive.

1.3 CREATING AND SAVING A DOCUMENT

Practice makes perfect

You still should have open the Conference Call Letter, with the Jonathan Livingstone
Seagull quote. You need to clear the Seagull quote from the document, so here are the steps
to remove it.

In the Edit menu choose Select All then press the Backspace key once
to remove the highlighted text from the document

You can also Select All using the Quick Keyboard command Ctrl+A, or you can use the
mouse (or your finger if you have a touch screen) to drag to highlight the whole paragraph,
or you can triple click on the paragraph.

Notice that the Backspace key removes all highlighted text. The Del(ete) key, in this
case, does the same.

Typing the Conference Call Letter
You should now have a blank page with the cursor waiting in the top left corner, ready for
you to type in the Conference Call Letter. Fig. 1.10 on the next page has the full text of the
Conference Call Letter. The Figure also shows where all the Paragraph marks () are. This
will help you remember to hit the Enter key only where necessary, not at the end of every
line. There’s no need to show Paragraph marks in your version of the document.

As you type, Writer will automatically warn you of any spelling or grammar errors it
finds (by underlining them in red or blue on your screen). This will occur as you type the
contents of Fig. 1.10.

14
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Jane Doe{ Type vour own name here so-your instructor lmows who youw are)”
n

Biwi Secondary School”
P.O.Box 10647

Lilongwe, Malawi”
o

o
Mr-and Mrs M Mayosha ©
Hastings Banda Street,”
PO.Box- 3353727

Lilongwe, Malawi”

-

Dear Mr-and Mrs -Mayosha ©

T

I'am-pleased to inform-vou that vour- danghter, Hellen, has been selected by the Fifth Grade teachers to
represent Biwi-Secondary School as-a Junior Biologist at-the National Marine Biology Instiute in T ake
Malawi National Park - Since Hellen has shown both academic-excellence and sound social skills this
pastschool vear, she-would be a great-candidate for the program. We very much hope-that youwill
suppoit Hellen m-this opportunity™

Ll

The Institute has-a wonderful reputation for both child and adult programs. Ihave attended the facility
myself and had a wonderful time. {Hellen would take part in a two-week session in June with %
graders from-all- over Malawi. T

Ll

Please callme-(61%)-772-3232 or email me-(mprendergast@biwis econdary. edu) to-discuss more- details
gbout the program. [look forward to-hearing from vousoon.”

e
Sincerely vours,T

-

-

e

Ms. Mary Prendergast”

Head of Science ©

Fig. 1.10 First version of the Conference Call Letter

Once you have typed in the whole document and saved it, you should go back and correct
any errors you may have made, and then save the document again. Remember: when you
save a document with the same name as before, you are replacing the earlier version. You
won't be creating a second copy.
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1.4 UPDATING AND SIMPLE FORMATTING OF A DOCUMENT
Now that your letter is saved on disk, you can make any revisions you want.

Word processing allows you to treat text like modeling clay. You can easily mold your
words and ideas. You can change margins, put in underlines, italics, boldface, and so forth.
You can correct errors, move text around, lay it out on the page—all at the touch of a few
buttons. In the next lesson (Lesson Two) you will have an opportunity to become quite
sophisticated in this regard. But let's keep it simple for now. Refer back to Fig. 1.10 while
you complete the next few sections of the tutorial.

Inserting the date
There is no date on the Conference Call Letter in Fig. 1.10. A letter is incomplete without a
date, so here are the steps to have Writer put today's date in the letter.

Click to position the insertion point cursor at the end of the Biwi
Secondary School address at the top of the page (after “Malawi”), then
press Enter

The cursor should now be waiting at the beginning of the next line.
In the Insert Menu > Field Menu click on the Date tool (Fig. 1.11)
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Fig. 1.11 Inserting the Date into a document
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As soon as you click on the Date tool, Writer immediately inserts today’s date at the cursor.

There is, however, one problem with the all-numeric date format (all numeric)—it uses
the USA style, with the month first and the day second. Elsewhere in the world, the date is
shown with the day first and the month second. So, where you have 3/4/2016, is that March
4, 2016, or April 3, 20167 You really can’t be sure.

Fortunately, LibreOffice has a quick way around that problem by allowing you to select
another format for the date which spells out the month and thus can in no way be confused.
Here’s what you need to do.

Use the mouse to right click on the date, and in the context menu that
pops up, select Fields...

The Edit Fields dialog box comes up, enabling you to select from a long
list of possible date formats (Fig. 1.12)

Edit Fields u
Type Select Format
Do [Wbate e 2731/%
Date 12/31/199%
Dec 31,99
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31. Dec. 1993

December 31, 1999
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Fri, Dec 31,99

Fri 31/Dec 9%

Fri, December 31, 1999
12-31
99-12-31
1999-12-31
12/99

Dec 31
December
4th quarter 99
1

Additional formats...

Offset in days
0 =

oK Cancel Help

Fig. 1.12 Selecting a commonly-recognized date format

In the Select column, click on Date (not Date(fixed)), then in the Format
column select the date format Friday, December 31, 1999 and click on
OK

Now check the new format for the date; there’s no question which date you’re referring to
now, right? You’ll appreciate the advantage of allowing Writer to insert the date for you as
not fixed because it will updating automatically when you save the letter as a template. Later,
any time you use the template, or print another Conference Call Letter, the date will be
adjusted automatically to reflect the current date on which you edit or reprint the document.
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Adding text to an existing document
You will most always want to add text to an existing document—make revisions and so
forth; it is an activity which is fundamental to the whole process of writing. On a typewriter,
or if you write a document by hand, making any kind of change is usually messy, and often
difficult to do. When you use the word processor, however, it is a simple task. Let's practice
now.

There is no limit to the extra details that could be added to the letter, but for the sake of
this exercise you will add just one sentence to the next to last paragraph to help the parents
appreciate what Hellen will get out of the experience at the Institute.

Position the insertion point cursor so it is at the END of the paragraph
which begins "The institute has a wonderful reputation..."—so after
the phrase “...all over Malawi.”, then press the space bar once and
type the sentence:

She would thus be able to meet and make friends with others of her
own age and academic ability.

Read over the sentence you just typed to check for errors. Correct any you may have made.
Before you go on to the next section you should save what you have done so far.

Press Ctrl+S to save the changes you have made to the letter

Removing text
There are several ways of removing text. In a moment you'll learn how to highlight a block
of text in order to move or delete larger sections of text. But if all you want to do is remove
a few words, or a short sentence, the quickest way is to use the Backspace key.

You are going to remove the second sentence of the second paragraph. This second
sentence begins "I have attended the facility myself...".

Position the insertion point cursor at the beginning of the third
sentence of the second paragraph—the sentence that begins "Hellen
would take part ..."

Press the Backspace key as many times as is necessary until the
second sentence of this paragraph (the sentence that begins “I have
attended the facility...”) is removed from the letter

You'll find the automatic repeat feature of the keyboard (activated by holding down a key
such as the Backspace key) will come in handy for a delete operation like this.

Press Ctrl+S again to save the changes you just made
Changing text
It is often necessary to change a word or words here and there in a document. The
Conference Call Letter overuses the word "program,” for example. The word appears once
in the first paragraph and then is used twice in the final paragraphs. To improve the letter it
would be better to rewrite the first sentence of the second paragraph to read: "The Institute
has a wonderful reputation for its offerings for both children and adults."
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Place the cursor between the period (full stop) and the "s” at the end
of the first sentence in the second paragraph (right at the end of the
word "programs” but before the period (full stop))

Use the Backspace key to remove the text “both child and adult
programs”
Make sure there is still a space after the word “for”, then type the phrase
“its offerings for both children and adults.”
Another change you need to make is to the telephone number in the first sentence of the last
paragraph. A common error with numbers is called transposition, where one accidentally
reverses the order of digits. The number is supposed to be 772-3223, not 3223.
Position the cursor just at the end of the telephone number, press the
Backspace key 2 times, then type the digits "23", and press Ctrl+S
At this stage your Conference Call Letter should look much the same as Fig. 1.13.

Jane Doe-{ Type your owr name here so-your instructor lnows-who you are)”
c

Biwi Secondary School”
P.O.Box 10647

Lilongwe, Malawi®
Thursday, September 1, 20167
-

Mir-and Mrs. M Mayosha,©
Hastings Banda Street,”

P.O. Box-333727

Lilonzwe, Malawi®

m

Dear Mr-and Mrs - Mayosha,©
.

[ am-pleased to-inform-you that yvour-daughter, Hellen, has been selected by the Fifth Grade teachers-to
represent Biwi- Secondary School as-a-Junior Biologist at-the MNational Marine Biology Institute in L ake
Malawi National Patk - Since Hellen has shown both-academic-excell ence and sound social sklls this
past-school vear,-she-would be a great candidate for the pro gram. We-very- much hope-that youwill
suppott Hellen i this-opportunity™

Ll

The Institute has-a wonderful reputation for its-offerings for both children and adults. T-have-attended
thefacility myself and had a wonderful time. Hellenwould take patt in-a two-week session in-June

with 5% graders-from-all over Malawi.-She would thus be-gble to-meet and make friends with others-of
her-owtrageand academic-ability. T

Ll

Please-callme (619 772-3232-or email me-(nprendergastfl biwis econdary. edu) to-discuss more details
about the program.-Ilook forward to -heanng from-yousoon.

Ll
Sincerely vours,”
T
Ll

1

s Mary Prendergast’

Head of Science”

Fig. 1.13 Intermediate version of the Conference Call Letter
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Selecting (highlighting) a block of text

Let’s take a few minutes to learn about highlighting text in a Writer document. Highlighted
text is text that stands out from the rest of the document because, in the case of LibreOffice,
the background of the highlighted text becomes a block of light blue color (Fig. 1.14).

Biwi- Secondary | School”
PO Box 10647
-

Fig. 1.14 Highlighted text

When you highlight text, you can do things to it (delete it, move it, copy it, change the
margins set for it, change the font, the text style or color, and so on) without affecting the
rest of your document.

You can highlight a single character...

Use the mouse to position the cursor so it is immediately before the "B"
in “Biwi” in the address at the top of the letter

Hold down the left mouse button and keep it down as you carefully drag
across just the "H" at the beginning of the word so that it becomes
highlighted

This latter operation is tricky the first few times you try it. If you drag across more than just
the "H", keep your finger on the left mouse button and drag back until you have just what
you want highlighted. You can select as much or as little of the text as you want. Remember,
you're in control.!

Let go of the left mouse button when just the "H" is highlighted

Now click anywhere in the text to remove the highlighting (i.e. to deselect
the selected text)

Try this a few times on different letters anywhere in the document
Double clicking to highlight a single word...

Position the I-beam cursor anywhere over the word "Secondary” in
the first line of the address at the top of the letter and double click
the left mouse button

The single word "Elementary" should be highlighted on the screen.
Click anywhere in the text to remove the highlight

L If you are new to word processing, the secret here is: don't panic! No matter how much you might think to
the contrary, when you're working with computers you are in control—as long as you know what you're
doing. The computer is just a dumb machine designed to serve your information processing needs. These
tutorials will help you make this dumb machine your friend.
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Try this on a few more words anywhere in the document till you're
comfortable with the action

Triple clicking to quickly highlight a sentence...

Position the cursor anywhere in the middle of the first paragraph in the
body of the letter paragraph and triple click on the left mouse button

Click anywhere in the text to remove the highlight, then try this again on
other sentences elsewhere in the document till you're comfortable with
the action

Quadruple clicking to quickly highlight an entire paragraph...

Position the cursor anywhere in the middle of a paragraph and
guadruple click on the left mouse button

Click anywhere in the text to remove the highlight, then try this again on
another paragraph elsewhere in the document till you're comfortable
with the action

You can highlight an extended area (or block) of text...

Place the cursor right at the start of the first paragraph of the letter
(before the sentence that reads: | am pleased to inform you... )

Now, while you hold down the Shift key, click at the end of the last
paragraph (after the sentence that reads: | look forward to hearing
from you soon. and notice that the whole paragraph is highlighted

Click anywhere in the text to remove the highlighting

You can quickly highlight an entire document...

You should be getting the hang of this highlighting by now. You can drag the mouse to
highlight several paragraphs or even an entire document of several pages. However,
dragging through a 50 page document would quickly become tedious. So Writer provides a
short cut to select an entire document—you may recall using this feature earlier in the
tutorial.

Press Ctrl+A (or in the Edit menu choose Select All)
Simple; now click anywhere in the text to remove the highlighting

Using the Writer Indent Markers
The letter is nearly ready to be printed. There are just a couple more changes you need to
make.

For example, one style for letter—writing is to indent the first line of every paragraph
7. Another is to position the first address (the address of the sender) so it appears at the
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top right of the first page, instead of on the left. In this case, the closing signature could also
be aligned on the right side of the page at the end of the letter. Put your thinking cap on
now, because what follows can be tricky for some. Fig. 1.15 illustrates these final changes
you are going to make to the Conference Call Letter.

Jane Doe

Biwi Secondary School

P.O. Box 1064

Lilongwe, Malawi

Thursday, September 1, 2016

Mr. and Mrs. M. Mayosha,
Hastings Banda Street,
P.O. Box 33572

Lilongwe, Malawi

Dear Mr. and Mrs. Mayosha,

| am pleased to inform you that your daughter, Hellen, has been selected by the
Fifth Grade teachers to represent Biwi Secondary School as a Junior Biologist at
the National Marine Biology Institute in Lake Malawi National Park. Since
Hellen has shown both academic excellence and sound social skills this past
school year, she would be a great candidate for the program. We very much hope
that you will support Hellen in this opportunity.

The Institute has a wonderful reputation for its offerings for both children and
adults. I have attended the facility myself and had a wonderful time. Hellen would
take part in a two-week session in June with 5" graders from all over Malawi. She
would thus be able to meet and make friends with others of her own age and
academic ability.

Please call me (619) 772-3232 or email me (mprendergast@biwisecondary.edu)
to discuss more details about the program. I look forward to hearing from you

soon.
Sincerely yours,

Ms. Mary Prendergast

Head of Science

Fig. 1.15 The final version of the Conference Call Letter
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Using the Indent Markers

Moving small indent markers is a delicate operation; be sure to position the very tip of the
mouse pointer on an indent marker (Fig. 1.16) as you complete the following exercises.

The tip of the —
mouse pointer is the
Hot Spot

Fig. 1.16 the Tip of the mouse pointer is the Hot Spot!

Indent Markers are used to adjust the first line margin, and the left and right margins, of
paragraphs—mnot individual lines, unless a paragraph only has one line.

On the left side of the ruler, at the 0" hash mark, you can see the two indent markers that
are used to set the First Line Indent and the Left Indent for paragraphs (Fig. 1.17). On the
right side of the ruler you can see the Right Indent marker (Fig. 1.17 again).

Right Indent marker

First Line Indent marker

L 1 2 3
RN 1 ! 2 ! 3 !

Left/Hanging Indent marker

=
FLn

=]

Fig. 1.17 The Indent Markers

In this exercise you will practice using just the First Line Indent marker and the Left Indent
marker. In Lesson 2 you will have plenty of opportunity to learn about the Hanging Indent
and the Right Indent markers.

Let’s learn how to use the First Line Indent marker now.

Click to put the cursor anywhere within the first paragraph of the letter
(this tells Writer which paragraph of text to reformat)

In the Ruler bar, place the tip of the mouse pointer on the First Line
Indent marker (see Fig. 1.17 above), and now use the mouse to drag
the First Line Indent marker across '2” to the right (to the %2” hash
mark on the ruler)

Notice that the First Line Indent marker (the upper triangular marker) and the Left/Hanging
Indent marker (the lower triangular marker) moved independently and that only the first line
of the paragraph has moved to the right half an inch (¥2”).

Next you are going to set the First Line Indent marker for the second and third
paragraphs in the body of the letter.

First, make sure you can see the whole letter in the window (maximize
the window if necessary), then click to position the cursor before the first
word of the second paragraph (before “The Institute...”)
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Now, while holding down the Shift key, click at the end of the third (last)
paragraph (after the words “...from you soon.”)

Both the second and third paragraphs of the letter should be highlighted.

Now position the tip of the mouse arrow on the First Line Indent
marker and slide it to the right to the %2” hash mark on the ruler bar

Notice that the first line margin of each paragraph is now set at ¥2" and the rest of each
paragraph is set at 0”.

Practice makes perfect
If this is the first time you've used these markers you may still feel uncomfortable working
with them, if only because they’re rather small and may be difficult for you to grab with the
mouse pointer. More practice will cure that.

Next you are going to use the Left Indent marker to adjust the left margin for the First
Address and the Date at the top of the letter, and then do the same to the left margin for the
sign off at the end of the letter. Follow these steps carefully.

Drag to select (highlight) the First Address and Date lines at the top of
the letter (the first four lines of text after your name)

Point at the Left Indent marker (the small marker at the bottom of the
indent markers on the left of the Ruler bar), hold down the left mouse
button and drag both the First and Left indent markers together over
to the 4" hash mark on the ruler

Let go of the mouse button, then click anywhere in the text to de-select
the highlighted text

The address and date should now be lined up on the new 4" margin. Fig. 1.18 illustrates the
change this makes to your letter.

Jane Doe (Type your own name here so your instructor lmows who you are)”
-

Biwi-Secondary School”
PO . Box 10647
Lilongwe, Malawi®

Friday. September-2,-201 d"

=
Mr-and Mrs M Mayosha,”
Hastings Banda Street.T
PO Box 333727

Lilongwe, Malawi”
-

Fig. 1.18 First address after changing the indent markers
If you weren't successful the first time, just go through the steps again to get the hang of it.
Next scroll down to the end of the letter if it doesn't show on the screen

Select the lines that begin: "Sincerely yours," and that conclude with
"Ms. Mary Prendergast" and “Head of Science” (including all three of
the blank lines in between)
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With these lines highlighted, again point at the Left Indent marker, hold
down the left mouse button and drag both the indent markers together
over to the 4" hash mark on the ruler

Press Ctrl+S to save this (almost final) version of the document

1.5 CHECKING THE DOCUMENT FOR SPELLING ERRORS
LibreOffice comes with a spelling checker. No matter how good you might think your
spelling is you would do well to take advantage of this fast, effective tool for catching
spelling errors or typos.

Encourage your students to use a spelling checker when they are proofing their word
processed work. The system will highlight any words that it cannot find in its dictionary and
may make suggestions for words or spellings the student intended. It can thus help your
students become better spellers, and broaden their vocabulary if they are curious enough to
check out the meanings of the words they may never have come across before.

However, it cannot spell for them—yet! Nor can it correct errors such as the misuse of
"to", "too", and "two"! A spelling checker is not an alternative to proofreading. Tell your
students they should always proofread their work on the printed page (in hard copy form)
after they have run it through the spelling checker. It also would be a good idea to have
another student proofread papers for them. Assessing a classmate’s work is a valuable
collaborative learning experience.

Accessing and using the spelling checker
In the Standard Toolbar click on the icon for Spelling and Grammar

(Fig. 1.19)
Spelling and Grammar in'@i&
File Edit View Insert Format Styles Table Tools Window Help Ve tOOI V )("-
B8R dea%ee 3o - auT 20T =R Q=
TetBody  [v] (& @) [TmesNewkomar] 2 7] @ @ @ -& @by & & - - =-1=- g »

Fig. 1.19 The Spelling and Grammar tool in the Standard toolbar

This will bring up the dialog box shown in Fig. 1.20. The Writer spelling and grammar
checker is probably already working for you if those functions are in automatic mode, and
if you see strange looking red or blue underlines under some of the words you typed.

If Writer highlights a word or phrase, this does not necessarily mean there is anything
wrong with it. You still have to be able to tell if you have made an error and you also need
to know what, if anything, to change. Sometimes you’ll ignore the spelling/grammar
checker.

Remember, the computer is just a dumb machine—it is a tool to assist your intelligence,
not replace it!

If you tell the Spelling Checker to check your document, and it has "No suggestions"
for a word highlighted, the dialog box gives you the option to have the Spelling Checker
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Ignore it (because the word is correct as is); or Ignore All occurrences of the same word in
your document (because you don’t want the Checker to stop for them again); or Add the
word to the custom dictionary (so it won’t be flagged in future documents you work on).
This is generally useful for proper names.

Spelling and Grammar: English (USA)

Text language: |“§? English (USA] |Z|

Mot in dictionary

Iam pleased to inform you that your dayghter, has been selected -
by the Fifth Grade teachers to represent @iwgSecondry School as a Junior
Biclogist at the Mational Marine Biclog e in Lake Malawi National | _
Park. i

Ignore Once

Ignare All

i

fils Add te Dictienary

Seconder
Second

e
Always Correct

Check grammar

L

Fig. 1.20 Spelling and Grammar dialog box

In the example in Fig. 1.20, the word “Secondary” has been mistyped and, as you can see,
the misspelling was picked up by the spelling checker and drawn to your attention. The
spelling checker also suggests the correct spelling! To fix the problem, you just click on the
Correct button, and Writer will fix it on the spot.

At one time or another you will find all these features useful, so you should take the
time to check them out. For the most part the Spelling Checker is intuitive, and one of the
best things you can do at this time is take a few minutes to browse through the various
selections until you get a feel for what the Spelling Checker can do.

Using the Spelling and Grammar... option in the Standard Toolbar,
work your way through the Conference Call Letter and correct any
spelling or typing errors you may have made, then Save your work

In Lesson 2 you will make more extensive use of the Writer Spelling Checker.

1.6 PRINTING A FIRST DRAFT OF THE DOCUMENT

Print Preview—ing your work

It is always useful to preview your work on screen before sending it to the printer. In
LibreOffice, you will be able to preview your work in the Print dialog box before you send
it to the printer. Let’s see how this works.
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From the File menu select Print (or press Ctrl+P) and in the dialog box
that pops up (Fig. 1.21) click on the General tab

" T — A

General: |Libre0ffice Writer |Page Layout |Option 3 |

8.50 in (Letter)

Printer
eEL Preview your ]

/ letter here
0-4600 Series

Lexmark 4200 Series
Microsoft KPS Document Writer
Send To Onelote 2013 o

- .
 Detas >
Range and Copies
Mumber of copies |1 =

() Pages |1
Collate iz 3 2|3
Selection 1 1

[T] Print in reverse page order

Print

11.00 in

@ All pages

Comments |Mone (document only) |

1| /1

o [ o

Fig. 1.21 Typical Writer Print dialog box

What kind of printer are you using?

If you have a laser printer, the quality is always "Best." But if you have an inkjet printer, for
example, you can choose the quality of output you require. You select the print quality by
clicking on the Properties button in the Print dialog box.

Printing a range of pages

With regard to Page Range, the Print All Pages option is selected by default. The
Conference Call Letter is only one page long, so you will by default want to print the entire
document. Should you want to print a subset of the pages of a long document, say from page
3 to page 6, you would click the radio button next to Pages (see Fig. 1.21 above) and enter
the numbers of the range of pages in the data entry box (ex. 1,3,5-12).

Setting the number of copies

Writer also asks you how many copies you want to print. As you can see (Fig. 1.21), the
number 1 is already selected by default, and for a draft copy that is certainly as many as you
would normally want. You are now ready to print the document.

Click on OK in the Print dialog box
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If all is well with your printer connections, your printer is turned on, and you have paper
correctly set up in your printer, it will now go ahead and produce a hard copy of your
document.

Removing your document from the printer
If you are using a laser printer or an ink jet printer, removing the paper from the printer is
simply a matter of picking it out of the paper tray.

Save the environment

A useful environmental tip, for your draft copies, is to reuse paper that has one side
blank. Keep a box near the printer where others who use the printer can deposit used
paper that is clean on one side. Only use new paper for a final copy of a document.

Always proofread your writing
Now you should take the time once again to carefully read over what you have typed.

If you used the Spell Checker, remember that it will not necessarily pick up all errors.
If you type "me" when you meant to type "he," the checker won't mind in the least, since
both words are in the dictionary. As we noted earlier, the golden rule here is: A Spelling
Checker is only as good as you are! You should never rely blindly on the feedback from the
Spelling Checker. So always proofread your writing—and tell your students to do the same.
You might also have your students proofread each other's papers. Let them be teachers, too;
it's a great way to learn!

You should also check the overall page layout to see that the document looks good on
the page. If there are problems, now is the time to fix them. Make all necessary changes on
the computer and save the document again on your disk drive.

If all is well, you are ready to go ahead and print the final version, the one that you will
send in the mail to the parents. Later, in Lesson 6, you will have the opportunity to learn
how to use Mail Merge to send individualized copies of a letter to a large number of
addresses.

1.7 RUNNING OFF A FINAL COPY
Follow the steps you learned above to run off a final copy of your document.

Most printers today will accept single sheets of paper. So if you wanted to use your
school's letterhead, this would be no problem. You would, of course, need to remove the
sender's address from the top of your Conference Call Letter since this address would
already be included on the letterhead paper.

1.8 MAKING A BACKUP COPY OF THE DOCUMENT
Your last task before completing this session at the computer should be to make a backup
of your document. For the sake of convenience, you’ll make the backup in the same folder
(the Data Files folder) as the rest of the data files you will create using these tutorials.

The Conference Call Letter is still open in Writer. It is also saved in your Work Files
for LibreOffice 5 folder, since that is where you have been saving it all along.
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From the File menu select Save As and in the Save As dialog box
make sure the Data Files folder is open, then change the file name to
Conference Call Letter Backup and click on the Save button

Wait while the file is being saved, then close Writer (File > Close)

LOOKING BACK

In this tutorial you have learned the basics of the LibreOffice Writer word processor. You
now know how to enter text, save it, revise it, set margins, check it for spelling, and print it
on paper in draft, standard, or letter quality. You also learned one way to make a backup
copy of your documents.

Many computer users learn no more than has been covered in this lesson. Under—
utilization is a common fact of life for most computer users; they never discover the wide
range of useful things the computer can help them do. Ideally, however, this tutorial should
have made you keen to learn more about Writer. Remember what you learned in Lesson 1.
You may need to refer back to some of the details spelled out here when you are using the
word processor on your own.

Above all, keep an open mind. It is almost impossible to know everything about the
computer, so there is always a lot to learn, even when you think you know it all!

LOOKING FORWARD
This has been a good introduction to the LibreOffice word processor. Lesson 2 will give you
an opportunity to further advance your skills.

Many of the word processing skills that you have learned will transfer across to other
word processors. The more you use the computer as a tool for writing, the more natural it
will become and the more you will improve your writing ability. The ease with which you
can make changes will have a significant impact on your willingness to generate quality
written communication. Needless to say, word processing will have the same effect on your
students, so the sooner you can get them using the computer for all their writing assignments
the better.

SKILL CONSOLIDATION
Complete these exercises to reinforce what you have learned in Lesson 1. This will help you
appreciate the usefulness of the word processor for all your writing tasks.

1. Use Writer to write a letter to someone in your family or to a friend using the same
layout as the Conference Call Letter. There must be at least four paragraphs in the body
of the letter. Print out a draft copy of the story, proof read it, correct any errors, then
print out a final copy of the story. Hand in both copies to your instructor.

2. Write a letter to a school district superintendent explaining the details of a field trip that
you are planning for your class. Print out a draft copy of the story, proof read it, correct
any errors, then print out a final copy of the story. Hand in both copies to your instructor.

29



ESSENTIAL LibreOffice: Tutorials for Teachers
Copyright © Bernard John Poole, 2016. All rights reserved.

. Write a short story of at least four paragraphs using Writer. Set the right and left margins
at 1.5 inches. Print out a draft copy of the story, proof read it, correct any errors, then
print out a final copy of the story. Hand in both copies to your instructor.

Use Writer to type up a paper of your choice. Print out a draft copy of the paper, proof
read it, correct any errors, and then print out a final copy of the paper. Hand in both
copies to your instructor.

Using Writer, type a paper of at least four paragraphs explaining what you have learned
so far in tutorial 1. Print out a draft copy of the paper, proof read it, correct any errors,
and then print out a final copy of the paper. Hand in both copies to your instructor.

Open Writer to create a new document. Name the document “A Day at the Beach” and
type at least four paragraphs on this topic. Practice adding and deleting words, phrases,
and whole sentences. Print out a draft copy of the paper, proof read it, correct any errors,
and then print out a final copy of the paper. Hand in both copies to your instructor.

Open the document named Conference Call Letter. Change the date so that it is the
current date, save the updated document. Remove all the first line indents from the
paragraphs. Add a paragraph explaining that if Hellen cannot attend the Institute this
year, the offer will be open again next year. Save the updated document. Print out a draft
copy of the letter, proof read it, correct any errors, then print out a final copy of the
letter. Hand in both copies to your instructor.
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